CHAPTER 10

Using Datasheets to Enter and View Data

Q.1: Answer the following as True or False.

(i) You cannot add or delete columns in the Datasheet view of a table.
(ii) In Datasheet view you can temporarily hide one or more columns.
(iii) Access automatically saves any changes that affect the underlying structure of a table.
(iv) If you delete a record and click Yes button to confirm your action you can still restore it using the undo command.

Answers: (i) False  (ii) True  (iii) True  (iv) True

Q.2: Enter data in the tables created in the School Database of previous chapter.

(a) Enter records in the Students table
(b) Use the Results table as a subdatasheet in Datasheet view and enter marks of two examinations of three subjects of all the students.

Answer:
Perform the following to enter data in Students table.
1. Open the Students table by double-click on it in the Database window.
2. In Datasheet view enter student data.
3. After entering student data, click on + sign in the current row left side of the Datasheet view to open subdatasheet.
4. Enter marks of examinations of subjects.
5. Repeat the steps 2-4 to enter data for remaining students.
6. After entering data click on close button to finish the task.

Q.3: Perform the following actions on Students table in Datasheet view to change its layout.
(a) Adjust the widths of columns.
(b) Increase the height of rows.
(c) Change the arrangement of columns.
(d) Temporarily hide columns.
(e) Display the hidden columns.
(f) Save the table with new layout.

Answer:

(A) ADJUST THE WIDTHS OF COLUMNS
1. Click on Format menu and select Column Width, the dialog box appears.
2. Enter desired value and click on OK button.

(B) INCREASE THE HEIGHT OF ROWS
1. Click on Format menu and select Row Height, the dialog box appears.
2. Enter desired value and click on OK button.

(C) CHANGE THE ARRANGEMENT OF COLUMNS
1. Locate the field that you want to relocate. Select the field label (name).
2. Drag the column to its new location, and release the cursor.
3. The column (field) is now in its new location and the order has been changed.

(D) TEMPORARILY HIDE COLUMNS.
1. Locate and select the field that you want to temporarily hide.
2. Click on Format menu and select Hide Columns.

(D) DISPLAY THE HIDDEN COLUMNS
1. Click on Format menu and select Unhide Columns, the dialog box appears.
2. Select the unchecked Columns and click on OK button.

(E) SAVE THE TABLE WITH NEW LAYOUT
1. Click on File menu and select Close option, dialog box appears, the Access will ask you to save changes in the layout of table “Students”.
2. Click on Yes button to save changes.

Q.4: Perform the following actions on the Students table.
   (a) Sort the records on First Name.
   (b) Find a particular record in the table.
   (c) Find and replace
   (d) Use Class or Section field as filter criterion and display the records.
   (e) Delete a record.
   (f) Edit data in a record.

Answer:

(A) SORT THE RECORDS ON FIRST NAME
1. Locate the field “First Name” that you want to sort.
2. Click on Records menu, move the cursor on Sort option, the sub-menu appears.
3. Click on Sort Ascending option.

(B) FIND A PARTICULAR RECORD IN THE TABLE
To search for and select records with field values that match a particular value, use Access’s Find feature. Follow these steps to find text.
1. In the table, select the field you want to search by clicking its header button.
2. Click the toolbar’s Find button or choose Find from the Edit menu to display the Find and Replace dialog box.
3. Type the test in the Find What text box. Making an entry in the Find What text box enables the Find Next command button.
4. Make sure the column label is selected in the Look In list box and that Whole Field is selected from the Match drop-down list.
5. Click the Find Next button. Access will search from the first record of the table and highlight the first match it finds or displays a message that it found no matches.
6. If a first match was found, click the Find Next button to find each subsequent match. You can also close the Find dialog box and continue the search by pressing Shift+F4 to find the next match.

(C) FIND AND REPLACE
1. Click on Edit menu and choose Replace option, the Find and Replace dialog box appears.
2. Type the text you want to search, in the Find What text box and also type the text with which you want to replace in the Replace With text box.
3. To replace entries selectively click the Find Next button and then click the Replace button for those records in which you want to replace the value.
4. You can do a bulk replace in all matching records by clicking the Replace All button.

(D) USE CLASS OR SECTION FIELD AS FILTER CRITERION AND DISPLAY THE RECORDS.
1. Open the table containing the records that you want to filter.
2. Locate a field that contains an instance of the value you want the records to contain. Select the text in the field.
3. Click the Filter by Selection icon in the toolbar or right-click on the selected field to produce a shortcut menu. Select Filter by Selection. Access displays a table containing all incidents of the field you selected.
   3. To further refine your search, select a second field from the filtered table and continue. For example, if your goal is to find all classes containing section A, you would next select “A” from the filtered table.

(E) DELETE A RECORD
1. Open your database file in Microsoft Access.
2. Use the F11 key to open the Database window.
3. Click on the Table tab to open the table window.
4. Select the table you want to use, then click Open.
5. To delete a record, put your cursor in the record you want to delete. Open the Edit menu and select Delete Record. Say yes when asked if you are sure.
(F) EDIT DATA IN A RECORD

You can enter or modify text in a field using the standard editing methods. For example, you can use the Left or Right arrow key to move the insertion point to the position in the text that you want to edit, you can use the Backspace key to delete the previous character or the Delete key to delete the following character.

Objective Questions and Answers

Multiple Choice Questions

1. In datasheet view information is arranged in
   (a) Rows  (b) Columns
   (c) Fields  (d) a and b both

2. Datasheet is the most common way of a table or a query.
   (a) Organizing  (b) Viewing
   (c) Arranging  (d) Analysing

3. In what view can you add, edit and delete records in a table?
   (a) The Datasheet view  (b) The Design view
   (c) A and B  (d) None of the above

4. A table in access is displayed in which two (2) of the following views?
   (a) plain view  (b) datasheet view
   (c) design view  (d) Both a & c

5. The current record is best described as the
   (a) record you are working on  (b) record you already saved
   (c) the pencil icon  (d) none of the above

6. The command that enables you to locate a specific record by searching a table for a particular value is called the
   (a) Replace command  (b) Search command
   (c) Find command  (d) Match command

7. A ______ displays a subset of records from a table according to specified criteria.
   (a) filter  (b) sort  (c) form  (d) query

8. A ______ lists a subset of records in a specific order such as alphabetically.
   (a) filter  (b) sort  (c) form  (d) query

9. The Remove Filter Button will
   (a) let you choose multiple sets of criteria
   (b) will sort fields in ascending order
   (c) will sort fields in descending order
(d) will return you to the original complete table

10. If you wanted to sort a field of last names from A-Z you would click the ______ button.
   (a) Filter by form      (b) Sort descending
   (c) Sort ascending     (d) Filter by selection

11. Which is not an option for customizing a datasheet window?
   (a). change one row’s height
   (b). hide one column
   (c). change one column’s width
   (d). freeze one column

12. What do you call the process of restricting the display of records in a table to
    those matching a particular criterion?
   (a) filtering          (b) restricting
   (c) sorting            (d) sifting

13. In a datasheet, what does each column represent?
   (a) Record            (b) Field     (c) Database (d) Table

14. In a datasheet, what does each row represent?
   (a) Record            (b) Field     (c) Database (d) Table

15. A ______ is a unit of information in a ______
   (a) record, field     (b) field, record
   (c) data source, field (d) record, data source

16. The arranging of data in a logical sequence is called
   (a) Sorting           (b) Classifying
   (c) Reproducing       (d) Summarizing

Check Your Answer

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>d</td>
<td>2</td>
<td>b</td>
<td>3</td>
<td>a</td>
<td>4</td>
<td>d</td>
</tr>
<tr>
<td>5</td>
<td>a</td>
<td>6</td>
<td>c</td>
<td>7</td>
<td>a</td>
<td>8</td>
<td>b</td>
</tr>
<tr>
<td>9</td>
<td>d</td>
<td>10</td>
<td>b</td>
<td>11</td>
<td>d</td>
<td>12</td>
<td>a</td>
</tr>
<tr>
<td>13</td>
<td>b</td>
<td>14</td>
<td>a</td>
<td>15</td>
<td>b</td>
<td>16</td>
<td>a</td>
</tr>
</tbody>
</table>

Short Questions and Answers

Q.1. In which form information is arranged in datasheet view.
   Ans: In datasheet view, information is arranged in rows and columns.

Q.2. What is datasheet?
(F) EDIT DATA IN A RECORD

You can enter or modify text in a field using the standard editing methods. For example, you can use the Left or Right arrow key to move the insertion point to the position in the text that you want to edit, you can use the Backspace key to delete the previous character or the Delete key to delete the following character.

Objective Questions and Answers

Multiple Choice Questions

1. In datasheet view information is arranged in
   (a) Rows          (b) Columns
   (c) Fields        (d) a and b both

2. Datasheet is the most common way of a table or a query.
   (a) Organizing    (b) Viewing
   (c) Arranging     (d) Analysing

3. In what view can you add, edit and delete records in a table?
   (a) The Datasheet view  (b) The Design view
   (c) A and B            (d) None of the above

4. A table in Access is displayed in which two (2) of the following views?
   (a) plain view          (b) datasheet view
   (c) design view         (d) Both a & c

5. The current record is best described as the
   (a) record you are working on  (b) record you already saved
   (c) the pencil icon           (d) none of the above

6. The command that enables you to locate a specific record by searching a table for a particular value is called the
   (a) Replace command        (b) Search command
   (c) Find command           (d) Match command

7. A ______ displays a subset of records from a table according to specified criteria.
   (a) filter   (b) sort   (c) form   (d) query

8. A ______ lists a subset of records in a specific order such as alphabetically.
   (a) filter   (b) sort   (c) form   (d) query

9. The Remove Filter Button will
   (a) let you choose multiple sets of criteria
   (b) will sort fields in ascending order
   (c) will sort fields in descending order
(d) will return you to the original complete table

10. If you wanted to sort a field of last names from A-Z you would click the ______ button.
   (a) Filter by form  (b) Sort descending  
   (c) Sort ascending  (d) Filter by selection

11. Which is not an option for customizing a datasheet window?
   (a). change one row’s height
   (b). hide one column
   (c). change one column’s width
   (d). freeze one column

12. What do you call the process of restricting the display of records in a table to those matching a particular criterion?
   (a) filtering  (b) restricting
   (c) sorting  (d) sifting

13. In a datasheet, what does each column represent?
   (a) Record  (b) Field  (c) Database  (d) Table

14. In a datasheet, what does each row represent?
   (a) Record  (b) Field  (c) Database  (d) Table

15. A ______ is a unit of information in a ______
   (a) record, field  (b) field, record
   (c) data source, field  (d) record, data source

16. The arranging of data in a logical sequence is called
   (a) Sorting  (b) Classifying
   (c) Reproducing  (d) Summarizing

Check Your Answer

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>d</td>
<td>2</td>
<td>b</td>
<td>3</td>
<td>a</td>
<td>4</td>
<td>d</td>
</tr>
<tr>
<td>5</td>
<td>a</td>
<td>6</td>
<td>c</td>
<td>7</td>
<td>a</td>
<td>8</td>
<td>b</td>
</tr>
<tr>
<td>9</td>
<td>d</td>
<td>10</td>
<td>b</td>
<td>11</td>
<td>d</td>
<td>12</td>
<td>a</td>
</tr>
<tr>
<td>13</td>
<td>b</td>
<td>14</td>
<td>a</td>
<td>15</td>
<td>b</td>
<td>16</td>
<td>a</td>
</tr>
</tbody>
</table>

Short Questions and Answers

Q.1. In which form information is arranged in datasheet view.
   Ans: In datasheet view, information is arranged in rows and columns.

Q.2. What is datasheet?
Ans: Datasheet is the most common way of viewing a table or a query. In this view, each column represents a single field in our database and each row represents a record.

Q.3. In which item is affected by changing in datasheet view.
Ans: When we make change in datasheet view only the layout of datasheet view is affected.

Q.4. Which techniques are resembled with the techniques for modifying the design of a datasheet?
Ans: Many of the techniques for modifying the design of a datasheet resemble techniques used in Microsoft Excel worksheets.

Q.5. How can you change the width of a column in a datasheet?
Ans: We can change the width of a column in a datasheet by dragging the right border of the column heading.

Q.6. How can you change the height of a row?
Ans: We can change the height of a row using a similar technique with the row selector, the button to the left of the row.

Q.7. How can Access determine the most appropriate width for the column?
Ans: Access can determine the most appropriate width for the column by double-clicking the right border of the column heading.

Q.8. Can you change the arrangement of the columns?
Ans: Yes we can also change the arrangement of the columns in a datasheet.

Q.9. Does changing the order of columns make effect on the underlying order of the fields?
Ans: Changing the order of columns in a datasheet as displayed in design view or other views.

Q.10. How can you change the field name?
Ans: We can change the field name by double-clicking the column heading typing a new name and pressing enter.

Q.11. What is the procedure to delete a column?
Ans: To delete a column select it by clicking the column heading and then choose delete column from the Edit menu. When we delete a column, we are permanently removing a field together with all its data from the table.

Q.12. How can we hide the columns?
Ans: We can temporarily hide one or more columns by selecting them and choosing hide columns from the format menu.

Q.13. What is the procedure to visible the hidden columns?
Ans: We can later make one or more hidden columns visible again by choosing unhide column from the format menu and selecting all the columns that we want to reappear.
Q.14. Does the Access save any changes that affect the underlying structure of a table?
Ans: Access automatically saves any changes that affect the underlying structure of a table renaming, adding or deleting a field, as well as edits to each record.

Q.15. How do we display a subdatasheet?
Ans: We display a subdatasheet by clicking the plus symbol (+) in the left Column of one of the records.

Q.16. What is the function of subdatasheet?
Ans: A subdatasheet lists one or more records from another table which are related to the records of the table displayed in the datasheet.

Q.17. Differentiate between the datasheet table and subdatasheet table.
Ans: Typically, the datasheet table is the primary table and the subdatasheet table is the related table in the relationship.

Q.18. How is the last row of a datasheet available?
Ans: The last row of a datasheet is available for adding new records and is marked with an asterisk (*) in the row selector at the left end of the row to indicate where the new record goes.

Q.19. How can you enter or modify text in a field?
Ans: We can enter or modify text in a field using the standard editing methods that all Microsoft office applications provide.

Q.20. What is the procedure to delete a record?
Ans: To delete a record, select it by clicking its row selector and then choose delete record from the Edit menu, click the delete record button on the toolbar, or press the delete Key.

Q.21. Is it easier to re-enter a record than a field?
Ans: Yes it is generally easier to re-enter a record than a field for all the records.

Q.22. How can you delete a group of records?
Ans: To select the records click the row selector of one record and drag the highlight up or down over the other records in the group.

Q.23. Which is the easiest way to sort the records in a datasheet?
Ans: The easiest way to sort the records in a datasheet is to designate a single Column of information to use as the sort key.

Q.24. How many ways to apply filters to the data in a table.
Ans: There are three different ways to apply filters to the data in a table.

Q.25. What does filter by selection allow us?
Ans: Filter by selection allows us to establish filter criteria for only a single field at one time. The records which are displayed depend on how we select text in the field.